
Ribbons 2: the sequel



In the previous presentation we looked at the ribbon as featured in File Explorer in Windows 10. We are now 
going to take a look at some elements of the ribbon common to all or most of the Microsoft Office applications in 
versions of Office since Office 2007. The programs we will touch on are Word, Excel, Publisher and PowerPoint.



The left-hand section of the Home tab of the ribbon in all these MS Office programs is called Clipboard, and we will 
look at what you can do here.

Cut and Copy both extract the selected item (picture or text) from your document, presentation or spreadsheet 
ready to put it somewhere else in the same or a different document, presentation or spreadsheet. The 
difference between the 2 commands is that Copy leaves a copy behind while Cut completely removes the item 
from its original location. Paste then places the cut or copied item into its selected new position in the same or 
a different document.

For quick and easy cut and paste or copy and paste operations the keyboard shortcuts of ctrl & c (to copy), ctrl 
& x (to cut) and ctrl & v (to paste) are worth remembering.



When you cut or copy something, Office stores it in a part of the system called the 
clipboard. As we said on the previous slide, clicking on Paste will insert the last item 
copied or cut. There are times, however, when we might want to paste something we 
copied earlier, and for this we need to reveal the clipboard by clicking on the little arrow 
in the bottom right corner of the Clipboard section of the ribbon (circled).

This will open the clipboard pane shown on the right. 
Clicking on any item in this area will paste it where your 
cursor is positioned.

When you have finished, you can hide the clipboard by clicking again on the arrow 
which opened it.



The final command in the Clipboard section is called Format Painter and this is a very useful tool.

It allows you to copy the formatting of any piece of text and apply the exact same 
formatting to another piece of text.  It means that the font, the font size, bold, italic, bold 
italic, paragraph spacing, line spacing, indenting, tabulation, alignment and even any 
hidden formatting such as hyperlink (although why you would want to copy this is not 
clear) will be copied and applied to the new, unformatted, or differently formatted text.  
Using format painter means you can make your document look more professional by 
having the same formatting throughout: especially useful if some or all of your text has 
been copied from a different document or the internet.  

To use format painter, you will need to click inside the text you want to emulate, then click on Format Painter, 
and finally drag your cursor over the text to be formatted to match the original.  You need to AVOID clicking 
anywhere other than the format painter while doing this or it will not work.   It is also possible to double click on 
the format painter icon to allow you to change the formatting of several non-contiguous pieces of text: the same 
formatting remains available until you click on the format painter icon again, thus releasing it. Please have a look 
at the examples on the next slide.



The piece of text on the left contains 3 different formats:
Body text is 11 point Calibri, the bulleted section is inset and has standard 
bullets, and the heading is 14 point Calibri, bold and underlined. 

If we want to apply the heading format elsewhere in the document 
we need to do the following:
1. Click anywhere in the text “Malware research project”
2. Click on Format Painter on the ribbon
3. Drag your cursor over the text to be changed: in this case the 

bulleted “Ransomware”.
4. This instantly changes format as shown (even though it makes 

no sense like this!)

If you double-click Format Painter instead of single-clicking it, the 
copied format can be pasted multiple times as shown on the left.
Once Format Painter has been double-clicked the command stays 
highlighted (as shown on the right) so that you can continue painting 
the original format until you click the command again to clear it.  



Immediately after the Clipboard section on the Home tab of the ribbon (except in PowerPoint where the Slides
section comes next) is the Font section, containing a vast array of ways to format your text.

In the main section of the HOME ribbon, you can see which font and size you are using, along with several buttons to allow 
you to increase the font size by one point, reduce it by one point, change the case, (e.g. all UPPERCASE, Sentence case, etc.).  
There is also a button for removing all formatting.  Another button allows you to use Word Art, to highlight, add shadow, 
reflection, etc., but be aware that some of these effects are only visible on a computer, and will not be available on a printed 
copy.

Formatting fonts can be exciting and can make any text look interesting.  There are many different fonts, some of which are 
handwriting styles, some of which are wingdings (this is a sample :this actually says this a sample in 
wingdings) and webdings (this is a sample :- this actually says this a sample in webdings).  Fonts can be 
changed by clicking on the little arrow in the right-hand bottom corner to open up a new window with many choices.  Here 
you can not only select a different font and font size, you can also change the colour of the text, apply bold, italic, bold italic
styles, underline style and colour.  You can also make your text superscript or subscript, for example to add the degree point for 
temperature, e.g. 200°C.  However, you will need to do this last by inserting a symbol from the extreme right of the insert 
ribbon and finding the correct symbol.  You can also add foreign language characters, mathematical symbols and lots more 
interesting things.  When you have time, explore symbols at length.  
Now, where was I?  You can also use strikethrough and double strikethrough, SMALL CAPS, ALL CAPS and 

.  On the Advanced tab you can also change the spacing of the text but this is normally not necessary unless you are 
creating technical manuscripts.



Note that the strikethrough, subscript and superscript options are not all normally visible on the ribbon. They 
can however be accessed by clicking on the arrow in the bottom right-hand corner of the Font section of the 
ribbon.  This will open the Format Cells dialogue box shown below.



Contextual areas of the ribbon

When you click on an image, shape or text box an extra tab will appear: this can be “Drawing Tools” or 
“Picture Tools” above the tab name of Format. The first 2 screenshots below show how this appears.

becomes

The Picture Tools/Format tab of the ribbon looks like this:

The Drawing Tools/Format tab of the ribbon looks like this:



It is also easy to insert a table into your Office program (except Excel) from the Insert tab. If you then click 
on the table two extra tabs will appear. 

Under the heading “Table Tools” they are Design and Layout,
and the screenshots below show the effects each can achieve.



Let’s have a look now at the Insert tabs in all these Office programs

All these ribbons have the following commands in common:

On the next few slides well have a look at these in turn.



As we’ve already mentioned tables, let’s start with them. The rest of this slide does not apply to Excel, in 
which table means something different – the whole thing is really a table, anyway!

In the other main Office programs click on the arrow below “Table” to open this screen:

The simplest method is probably to use the grid immediately below Insert Table to 
define the size of the table. As you move your mouse over the grid, cells highlight 
themselves in orange and a preview of the table appears on the actual slide or 
document.

You can also click on Insert Table which allows you to insert a table with more than 8 rows or 10 columns.
The final option is to insert an existing Excel spreadsheet.



Something we often need to do is add pictures to liven up our text or slide show. The Office programs 
allow us to insert both Pictures (from our own computer) and Online Pictures (from the internet). 
Clicking Pictures opens a small File Explorer window to enable picture selection, while the Online 
Pictures command opens the “Insert Pictures” window shown below.

If you want to use an online picture, typing your search criteria in the “Search Bing” field opens the final image above, 
with 3 images to choose from.  Simply click on “Show All Results” to reveal many more pictures which you can then 
select.
Beware of using copyright images as this can be illegal.



Still on the subject of images, once you have inserted the picture in your document, slideshow or spreadsheet you 
have options for changing the display. The pasted image looks like the first picture below, but handles appear when 
you click on it (second picture). Beware of distorting the image if you use one of the handles other than those at the 
corners.  

Right-clicking 
the picture 
generates this 
alternative 
menu:

One of the options is to crop 
the image (remove unwanted 
areas). Clicking on this adds 
black bars at the top, bottom 
and corners. The cursor will 
change into a T shape when 
you are in the right position: 
drag the black bars inwards 
to select the area to keep.



Another option on the right-click menu is Style. Click on the icon to open another window 
like the one below showing stylised versions of the different available styles.

The small images below 
show some of the 
available effects, although 
some effects can distort 
the image.



The last option we are going to explore on the right-click menu is Format Picture. Clicking on this opens 
another pane on the right of the screen, as shown below.

On the following slides we will have a look through some of the effects achievable here.



The first option in the Format Picture menu is Shadow. You 
can see in the screenshot here how many different ways you 
can add a shadow, and there are some examples below. You 
can even, bizarrely, have the shadow inside the picture using 
Presets.



The next option in the Format Picture menu is Reflection. 
You can see in the screenshot here how you can customise 
reflection, and there are some examples below. 



Next we come to Glow. You can see in the screenshot here 
the preset options, and there are some examples below. 



The next option is Soft Edges, the variations of which 
can be seen on the right. 

The examples below show what happens when the 
“Size” control is increased. 

8 point 27 point 61 point



3-D Format is the next command. The 
options are shown on the right and once 
again there are some examples below.  

Top bevel Morning lighting Freezing lighting



3-D Rotation is the next command. The 
options are shown on the right and once 
again there are some examples below. 
Some of these effects also distort the 
picture, so be warned if you are planning 
to use this command.

Isometric: top up Off axis 1: right Perspective: relaxed



Artistic Effects is the final command. The 
options are shown as thumbnails when 
the dropdown arrow          is clicked, as 
shown on the right.

Three of the available effects are shown 
below. 

Pencil sketch Pastels smooth Glow edges



A lot of similar formatting can also be applied to Shapes and Text Boxes, also available on the Insert
tab. The screenshot on the right shows the available shapes.

For presentations and documents shapes like these can be extremely 
useful for highlighting and identifying important parts:

Once a shape has been inserted, clicking on 
it will enable the Format tab where the fill 
colour and transparency, the border colour 
and thickness, and even rotation (using 
Shape Effects) can be adjusted.



The next item common to all Office ribbons is Header & Footer (but separate in Word).
Clicking either of these will open another tab called Header & Footer Tools (below).

You can see that once again the data in the header or footer is completely customisable. The 
screenshot on the right shows just a few options for Word headers using document title and page 
numbers. The screenshots below show options in PowerPoint and Excel.

Note that headers and footers are used most often in 
documents to be printed (including as pdf) or projected, 
rather than those to be viewed electronically.  Footers are 
often used for page numbering in documents to be printed.



The final item common to all Office ribbons is WordArt. Click on the downward arrow to 
open the window showing the main styles:
Click on any of these to insert a text box 
in the chosen style in which to insert your text.

The Drawing Tools tab will appear on the ribbon, allowing you to make changes to your WordArt and 
the border and background of its container. Some of the almost limitless possibilities are shown below.

Your text here

(using a picture as background)

(using reflection in text effects)



If you find yourself using one Office application regularly, it is well worth taking the time to get to know the ribbon 
specific to that program.

Each program has its own Help ribbon which for Word looks like this:

While these resources are useful, 
nothing beats hands-on practice.

Why not open a new presentation, 
document or spreadsheet and 
work your way along the toolbar 
inserting pictures, text etc. and 
formatting it as you go?

Anything you learn in this way is 
much more likely to stick in your 
memory.

We hope that you found this overview of Microsoft Office ribbons useful.

Clicking on the question mark icon opens a new pane on the right of the window. Those in Word, PowerPoint and Excel 
are shown below.



THE END
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